
WES-2 Bridge Job Sheets 
 
Note:  There are no significant changes between the 17.3.1 version and the 17.1.1 version of these 
jobsheets.  The only changes include updated version numbers and other minor edits.  The previous 
versions are perfectly acceptable for demonstration/instructional purposes, and this one may be helpful 
for verifying that functionality works.  Some of the figures were not updated if the only change was the 
version number. 
 
Basic Introduction. 
 
There are two main parts of the WES-2 Bridge interface:  a case manager and an instance manager.  The case 
manager displays the cases that are available for the particular user.  From the case manager, users start case 
reviews or simulations as well as load and unload cases.  The interactions primarily occur through right-clicking 
on a particular case. 
 
The instance manager allows you to start, stop, and reset any of the EDEX instances (independent versions of the 
main AWIPS server that each can hold a case and localization) as well as start additional CAVEs for each 
instance.  WES-2 Bridge comes with 5 EDEX instances, labeled EDEX_00 through EDEX_04, so you have 5 
AWIPSs on your WES-2 Bridge machine that can run at the same time and each have its own case and own 
localization. 

 
 
WES-2 Bridge also provides an updated scripting capability (WESSL-2; a misnomer, but a carry-over from the 
old WES-1 WES Scripting Language).  WESSL-2 adds some command and control capabilities to the simulation 
plus provides a method of viewing non-AWIPS data in a simulation.  While more features are planned, it is 
already very flexible because it contains the ability to issue any Linux command.   
 
Contents: 
 
This packet contains five jobsheets (with accompanying explanations).  These are examples of some the tasks 
you may complete with WES-2 Bridge. 
 
Task 1:  Import or Create a small archived case for event review 
Task 2:  Load a case and run a basic simulation.   
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Task 3:  Load a case and run a simulation with GFE functionality, including a short simulation with the winter 
Hazard Simplification (HazSimp) Formatters.    
Task 4:  Build a short WESSL Script and Play it in a Simulation 
Task 5:  Examine a Hydro case and run a simulation with Hydro Apps capabilities 
 
Task 1: Import (“Create”) a small archived data case for event review (no simulation).   
 
Concepts:   

• Examine a case as it came out of the archiver 
• Start WES-2 Bridge, if needed.   
• Start the EDEX_00 instance, if needed 
• Use the AWIPS Archive Case wizard to create a WES-2 Bridge case from the archiver-produced case. 
• Start another EDEX instance if needed 
• Load the case 
• Review the case. 

 
Note:  In operational practice, the archived case as it is produced by the AWIPS-2 Case Creation GUI is stored 
at /data/archiver.  These instructions use a case delivered via Blu-Ray disc and unpacked on your machine. This 
necessitates a few changes in these instructions than would normally would be done for a ordinary case.   These 
changes are notated below. 
 
Step-by-Step Instructions: 
 

1. Right-click on the desktop and select Open in Terminal to launch a shell window. Issue the following 
commands to list out the contents of an archived data case before the metadata is added: 
 

• cd /data1/wes_cases/W2B_17_3_1_ExerciseCase  
Note:  you can hit the tab key after starting to type out the paths and the terminal will sometimes 
finish the command for you 
 
Note:  In practice, you would use this command:  cd /data/archiver 
 

• ls  
 

• ls Processed 
 

• ls 
Processed/* 
 
Note:  Only 
some bufrua 
(soundings), 
grid (ETA, 
FFG, LAPS, 
MSAS), obs, 
redbook, 
satellite, 
sfcobs and 
warning data 
should exist in 
this case as 
shown here. 
 



 
2. If WES-2 Bridge is not already started, you can start it by navigating to Applications  WDTD  

WES-2 Bridge in the top-left Desktop menu.  
 

 
 
 

3. Once the WES-2 Bridge GUI appears, check to see if EDEX_00 is Active under the “EDEX Instances” 
list. If it is listed as Not Active, right click on EDEX_00 and select Start EDEX.  
 

 
 

4. Under the File menu select AWIPS Archive Case. 

 
 

5. In the first page of the wizard: 
 

• Click on the Browse button and navigate to /data1/wes_cases where you will select 
W2B_17_3_1_ExerciseCase.   
 
Note: In operational practice, this location will be /data/archiver.   
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

• Ensure the “Use original archived data and do not copy to an alternate location” checkbox 
is checked.   
 
Note: In operational practice, you will leave this box unchecked.  This will ensures the WES-2 
Bridge software copies data from /data/archiver to a case directory on the WES-2 Bridge box.   
 

6. Click the Next button. 
 

7. In the wizard’s second page enter the following information: 
 
 
Destination /data1/wes_cases/W2B_17_3_1_Exercise case 

(This choice is grayed out because of the check box on the previous screen.  Had we 
left it unchecked, then this dropdown box lists the available places on your WES-2 
Bridge machine where you can store case data.) 

Case Name Feb 23 LIX W2B Exercise Case 
(the spaces in this case name and the resulting directory name will be changed to 
underscores by the WES-2 Bridge software) 

AWIPS II Version 17.3.1  
(this is used for tracking build dependencies) 

Case Description archiver case with limited bufrua (sounding), satellite, obs, 
warnings, LAPS, FFG, MSAS data  
(this is useful documentation for later use; any comment listed here can be seen by 
any user who loads the case.) 

 
 



 
 

8. Click the Next button. 
 

9. In the WFOs box, you should select your own WFO.  This case was collected from the LIX WFO, and 
we packaged the localization for LIX with the main test case.  Cases that you make from your own 
archived data will need to use your own localization.    
 
Note:  If your WFO does not appear in the list, then you have not customized WES-2 Bridge with your 
own localization.  These job sheets pre-suppose that you have performed the local customization steps as 
described in the guide on “Customizing WES-2 Bridge with AWIPS Localizations” on WDTD’s WES-2 
Bridge web site at http://www.wdtd.noaa.gov/tools/wes2/documentation/LocalizationSteps.pdf. WDTD 
also has published a new script (/w2b/util/localizationcopy.csh) that simplifies copying the localization 
from your live AWIPS to your WES-2 Bridge workstation. There must be a cron job running on your 
PX1/PX2 that copies your localization daily to /data/archiver for this script to work correctly. 
 
Multiple WFOs may appear in this list, and the available WFOs may change depending on which cases 
are loaded into WES-2 Bridge at a given time.  The list is constructed from the localizations that are 
located in the /awips2/edex/data/utility/site and /awips2/edex/data/utility/configured directories. 
 
Note: If you had a lot of data you may choose to filter the data that would be loaded in WES by using 
the Data Types box. 

http://www.wdtd.noaa.gov/tools/wes2/documentation/LocalizationSteps.pdf


 
Note:  In this job sheet we are purposefully not using FSI.  In your office, if you choose to use FSI, then 
selecting this checkbox will require you to specify the location of Raw radar data for this case because 
that Raw radar data is required for FSI. 
 
On Localizations and Transferring WES-2 Bridge Cases.  At the current time, every case that is 
made on WES-2 Bridge also includes a copy of the localization.  This does result in multiple copies of 
the localization residing on the machine, which is inefficient.  However, this does make it easier to 
transfer cases to different WES machines (for example, to other WFOs).  All that is needed to transfer 
cases to other machines is to tar up an entire case (including the caseMetaData.xml file, the localization 
and Processed directories and any Raw and/or wessl2 directories that are part of the case.  Then simply 
untar the case on the target machine in one of the case directories (/data1/wes_cases, /data2, etc.) and 
refresh the case manager window.  After transferring the case, you will need to ensure the permissions 
on the case are set to group write (chmod –R g+w <caseDirectory>).  The size of the case will affect 
how the case is transferred (the physical media and any splitting up of the case into multiple tar files).  
Plans for future versions of the WES-2 Bridge software include not always copying the localization into 
every case and a “Package Case” option to make this process easier by grabbing the localization and by 
splitting up large tar files into manageable pieces.  In the meantime, if you have questions about doing 
transferring cases to other WFOs, contact WDTD for assistance. 

 
 

10. Click the Next button. 
 

11. On the wizard’s third page enter the following: 
 

• Start Date: 2016-02-23 12:00  
• End Date: 2016-02-24 06:00 

 
Note: You may want to use the Set Date button to select the time from the calendar to ensure you don’t 
make a typo. Also, you can hold down the arrows on the spin-boxes to rapidly index to a number. 
 
Note:  You may have noticed that the “Correct insert times for reprocessed data” is grayed out.  This is 
grayed out because of choosing the “Use original archived data and do not copy to an alternate location” 
check box above in Step 5.  Most of the time, the “Correct insert times” option is available to you.  If 
you are using data that came directly from your archiver, you should leave this setting alone.   If you 
have used rawPlay to reprocess raw radar and gridded data you must select this box for simulations to 
work correctly.  Eventually this will apply to datatypes other than radar and grids. 

 



 
 

12. Click the Finish button to create the case metadata.  It should take a couple of minutes to create the 
metadata and copy the localization.   

 
When WES is done creating metadata for the case, you will see Feb 23 LIX W2B Exercise Case listed 
in the Case Name list of Available Cases, and it will have a status of “Not loaded”.   

 
Note: If you do not see a particular case listed, check under Window  Preferences and make sure 
/data1/wes_cases has been added to your “Case directory paths”.   

 

 
 
 
 



13. In the terminal window from Step 1, issue the following commands to list the contents of the case after 
the metadata and localization are added: 
 

• cd /data1/wes_cases       
 

• ls W2B_17_3_1_ExerciseCase 
 

Note:  WES-2 Bridge changed the spaces in your case name to underscores for the case directory.  
The case name in the interface still contains spaces. 
 

Note:  The caseMetaData.xml and the localizations folder should now exist 
 

• ls W2B_17_3_1_ExerciseCase/localizations 
• cat W2B_17_3_1/ExerciseCase/caseMetaData.xml 

 
Note:  The localization tree and maps have been copied into the case from the AWIPS-2 installed on  
WES-2 Bridge.  The maps directory will only exist if you have customized your WES-2 Bridge 
machine with the maps from your operational AWIPS system.  For more information, see the 
“Customizing WES-2 Bridge with Local Maps” guide on the WES-2 Bridge web site at 
http://www.wdtd.noaa.gov/tools/wes2/documentation/LocalMaps.pdf. 
 
Note:  Beginning in WES-2 Bridge 16.2.2, part of the customization process involves copying 
Average Recurrence Interval (ARI) data into the localization in order to support FFMP’s usage of 
ARI.  Because it is static data (does not change in time), the ARI data is not normally available as 
part of an archived case.  For that reason, WES-2 Bridge implemented ARI as part of an addition to 
the localization.   
 

 
 

14. Right-click on the “Feb 23 LIX W2B Exercise Case” and select Load Case. 
               
In the Load Case tab, review the metadata, and then click Load to load the records into the database. 
 

• This will take a minute or two, and the Progress Information bar will disappear when the data is 
loaded into an available EDEX instance.  
 

• If there are no available (empty) EDEX instances, you will be prompted to unload an EDEX 
instance before being able to proceed.  
 

• If no EDEX instances are running, WES-2 Bridge should prompt you to start one. You can also 
manually start one by right-clicking on an instance in the instance manager and choosing “Start 
EDEX”. 

http://www.wdtd.noaa.gov/tools/wes2/documentation/LocalMaps.pdf


 
15. Drag the vertical bar (the right edge of the Available Cases window) to the right, so you can see that 

the Status of “Feb 23 LIX W2B Exercise Case” is Loaded and which EDEX instance (in the EDEX 
Instances window) the case is loaded on. 
 

 
• When a case is loaded, it can be quickly accessed for event review or simulation. 

 
Note:  “Loading” means that the Postgres database for a particular EDEX instance has been 
populated with data from a case and that the localization for the case has been linked into the 
EDEX. 

 
 

16. Right-click on “Feb 23 LIX W2B Exercise Case”, and select Review. 
 

17. In the Review Wizard, click Finish. 
 

• CAVE will load with all the data visible, and after 1 minute WES-2 Bridge sets the D2D clock 
to the end of the case for reference. 

 
Note: The D2D clock is frozen at the time of the end of the loaded case.   

 
18. Under the Satellite menu select Visible and navigate through the data.  

 
Note: This is static case review (no simulation), so the data doesn't update automatically, and D2D 
displays the last data in the case.  In case review, you can manually set the clock to an earlier time 
(and freeze it if you want to).  Loading data after setting the clock then causes data from the earlier 
time to appear (which occurs later in this exercise). 

 
19. Double-click on the D2D clock change the time to 2016/02/23 (Year/Month/Day) and 20/30/0 

(Hours/Minutes/Second).  Ensure the time is frozen with the Freeze time at this position checkbox 
selected. 
 

20. Swap panes with an empty pane and then swap the pane again.  The satellite data should now be at a 
time that ends just previous to 2030 UTC February 23. 



 

 
 

• Your CAVE clock should have yellow text with a red background when the time is frozen and is 
set backwards from the system time.   (This color configuration is part of AWIPS versions later 
than 16.1. Previous AWIPS builds had yellow text on a black background when the time was 
frozen.  The red background indicates the time is not the current system time.) 
 

 
 

• When the clock time is not set to the system time but is moving forward, the clock will have 
white text with a red background. 

 
21. Swap panes with an empty pane, and under the Obs menu select Other Warning Displays then All 

Regional Warnings and navigate through the data.   Since we created this case with your own 
localization, you may not see a display of warning polygons because this is a mostly southern US 
convective event.  The warnings that are displayed are the actual warnings that were issued during the 
event. 
 

22. Swap panes with an empty pane, and under the Volume menu select NAM80 and navigate through the 
data.  Clear this pane and then under the Volume menu select LAPS and navigate through the data.  
LAPS for this case uses the LIX domain.   
 
Note:  Some localizations may have removed LAPS from their main Volume menu and only have it as 
an option for the Surface Families menu under the Volume menu. 
 

23. Swap panes with an empty pane, and under the Obs menu select Station Plot (in the METAR section) 
and navigate through the data. 

 
24. Under the Upper Air menu, select US Eastern ► New Orleans, LA and verify the sounding appears in 

an NSHARP display.  
 

25. Under the MRMS menu and under the Hail Products menu, select MESH Tracks (1440 min. accum.) 
and notice no data will load because this data type (MRMS) was not included in this case. 

 
26. To launch another CAVE on this case, identify the EDEX Instance that contains this case in the Case 

Name list of available cases (EDEX_03 in the figure below), and then in the EDEX Instances on the 
bottom left of the WES -2 Bridge interface, right click on the appropriate EDEX Instance and select 
Start CAVE.   
 
 



 
 

• Click OK on the available memory popup window if it pops up. 
 

Note: You have to manually set the CAVE clock when using the Start CAVE popup when you are 
in review mode.. 

 
27. Load and view data on the new CAVE and verify it is the same data. 

 
28. Shut down CAVE. 

 
Note:  Any active EDEX started above will remain running even after shutting down CAVE. 

 
 



Task 2:  Load a Case and Run a Basic Simulation: WES-2 Bridge 17.3.1 Test Case (LIX 2016-02-23)  
 
Introduction.  EDEX_01 is an EDEX instance that is reserved for simulations on cases that are not already pre-
loaded, so you can load a case and run a simulation in one step.  After running the simulation or case review, the 
case remains loaded in EDEX_01.  The other instances (EDEX_02, EDEX_03, and EDEX_04) are designed to 
be used in a two-step fashion (loading the case and subsequently running a simulation or case review).  After 
running an initial case review or simulation on EDEX_01, EDEX_01 behaves like EDEX_02 through EDEX_04 
as long as the case remains loaded in EDEX_01.   
 
You will also use one of the two parts of WESSL-2, the WESSL-2 Event Browser, to view ancillary information 
included with the simulation.  
 
Concepts: 

• Start an EDEX instance 
• Load a simulation 
• Start the simulation with a sample WESSL script. 
• Observe the events from the sample WESSL script. 
• Issue a warning 
• Stop the simulation 
• Find the text file that contains the warning (for subsequent evaluation purposes). 

 
Step-by-Step Instructions: 

 
1. In the WES-2 Bridge Case Manager, determine if any of the EDEX_02, EDEX_03, or EDEX_04 

instances are both Active and have no case loaded.  If needed, start and/or reset an instance by right-
clicking on the instance in the instance manager, and selecting “Start EDEX” or “Reset EDEX”.     
 

2. Load the WES-2 Bridge Test Case by selecting WES-2 Bridge 17.3.1 Test Case (LIX 2016-02-23), 
then right click and select Load Case.  It may take about 10 minutes to load the case. 
 

3. Start the simulation by selecting WES-2 Bridge 17.3.1 Test Case (LIX 2016-02-23) in the Available 
Cases tab, and right click and select Simulation. 
 

4. In the Simulation tab (may need to move the right-edge vertical bar to see) enter the following: 
 
 
Load Data Time Range 
Start Date 2016-02-23  12:00 
End Date 2016-02-24  12:00 
Simulation Data Time Range 
Start Date 2016-02-23  22:20 
End Date 2016-02-23  22:55 
WESSL Script TestScript 
Remove Warnings from WFO is checked. 
 
Verify your settings with the graphic below.   
 
Note:  Notice the Input Data Directory and the Output Data Directory (highlighted in red).  Beginning in 
the 17.1.1 version of WES-2 Bridge, these locations are available to make the process of initializing a 
simulation and gathering evaluation data from a simulation much easier.  The output directory is 
automatically filled in by the system based on the name of the case and the system time. 



 
 
 
 



 
5. In the upper-right part of the simulation tab (may need to use scroll bars), click on the Simulate 

button. 
 

• Several windows will begin to pop-up, including the WESSL-2 browser. 
 

 
6. Click OK on the available memory popup window if it pops up, and note when the WESSL-2 window 

and Simulation Controls window pops up. 
 

7. After CAVE finishes loading, click the PLAY button on the Simulation Controls window. 
 

8. This WESSL-2 script will pop up several events at the beginning of the simulation, one at 22:27 and 
another towards the end (at 22:51 UTC), and you can click on each one of the WESSL Events manually 
if you want to review them. 

 
This WESSL-2 script does not demonstrate all the functions possible.  WESSL-2 can pause a simulation 
at prescribed times, and it can play audio and video clips, display web (HTML) pages and run any 
system command.  Therefore, there are numerous possibilities of displaying ancillary information 
alongside your simulation, limited mostly by one’s creativity.   Task 3 below demonstrates adding 
observations (spotter reports) by importing files downloaded from SPC.   
 

9. From the klix menu, select 0.5 Z+SRM8 and review the recent radar data.   
 

10. Under the CAVE menu and New submenu select Text Workstation, and then issue a tornado warning 
with WarnGen (don’t spend much time doing it -- this is just for demonstration purposes), making sure 
to select a basis for the warning (radar detected, spotter, etc.) and/or hail or wind threat.   
 
 

• If you receive a message about product expiration, click the “Go Ahead” button.  The AWIPS-
2 issue that is responsible for this notice also was verified to be fixed in AWIPS 16.4.1. 
 

• If warning product does not display in the Text Workstation after you select “Create Text” in   
Warngen, navigate to CAVE  Preferences  Text Workstation and make sure the host 
matches the workstation name you are running WES II Bridge from. 
 
Note:  The AWIPS version packaged with previous builds of WES-2 Bridge did not allow 
PathCasts in WarnGen to function correctly.  From the 17.1.1 build forward, the AWIPS code 
was fixed to allow generation of PathCasts. 
 

 
11. In a new pane, load the Local CWA Warnings plot from the Obs menu, and see your new  
      Warning polygon. 
 
12. The simulation will stop automatically at 22:55:00.  If you have finished issuing your warning, you can 

manually stop the simulation at any time by pressing the STOP button in the Simulation Controls 
panel. 
 

• Note: In WES-2 Bridge 14.3.1, it was critically important to actually STOP the simulation by 
using the STOP button or allow it to finish naturally.  This ensured that radar and other data 
were ready for the next simulation or review used on a particular case.  In Builds 16.2.2 and 
later, WES-2 Bridge improved the methodology of loading radar and other data to remove this 
dependency and this problem should no longer occur. 



 
• After the simulation has stopped, shut down CAVE and the WESSL-2 Event Browser.  

 
 

13. In order to locate and examine the text file that contains your warning (for later evaluation purposes), 
open a terminal window (right-click on desktop and select “Open in Terminal”) and issue these 
commands: 
 

• cd /data1/wesSimData 
• ls 

 
There should be a directory named WES_2_Bridge_1731_Te_ followed by twelve digits that represent 
the system date and time when the simulation was started.  Inside this directory you should see at least a 
text directory and a warnings directory.  These contain the text products issued during the simulation in 
plain text format (*.txt files) for human perusal and in a binary format (*.bin files) suitable for loading 
back into the AWIPS databases to use in subsequent simulations. 
 

 
Note:  The warning text is also available in the fxatext database and in the warning table of the 
metadata database. Both of these can be accessed via pgadmin or psql. 

 



Task 3:  Load a case and run some short simulations with Graphical Forecast Editor (GFE) functionality. 
 
Introduction.  Beginning with Build 17.1.1, WES-2 Bridge includes support for basic GFE functions.  It uses 
archived GFE data so that both gridded and text forecasts can be produced along with hazard products.  
Simulations can be initialized with either an archived Fcst database or with a Fcst database prepared for a 
particular training objective.  Simulations can also be initialized with text and warning products. 
 
This task illustrates how to use these functions.  There is a special checkbox when a case is loaded to ensure 
GFE functions are enabled.   The standard GFE functions of populating and editing grids, saving the Fcst databse 
and running formatters should operate normally. The final steps depict a second simulation that loads the output 
from a previous simulation for review purposes. 
 
Note:  Some particular WFO GFE procedures and SmartTools may be written specifically to work with specific 
versions of models without consideration of how models may have changed from previous archived versions.  
These types of local software issues are beyond the scope of the WES program. 
 
Concepts:   

• Load a case that contains only unmodified GFE data (no pre-initialized Fcst database) 
• Populate Fcst grids with some model data  
• Edit the hazard grid 
• Save and Publish the Fcst database 
• Run some formatters to create text products 
• Run a second simulation to examine pre-created Fcst database and text products. 
• Run a third simulation to generate a winter storm watch using the Hazard Simplification (HazSimp) 

winter formatter.  
 

Step-by-Step Instructions: 
 

1. In the WES-2 Bridge case manager, right-click on the “WES-2 Bridge 17.3.1 GFE Case (LIX 2016-
02-23)” and select Load Case.   
 
Note:  This step assumes there is an empty EDEX instance.  If all three of EDEX_02, EDEX_03, and 
EDEX_04 contain cases, you will have to unload one of them in order to perform this step and continue.  
This also assumes that one of your empty EDEX instances is active.   
 
 

2.  Start the simulation by selecting WES-2 Bridge 17.3.1 GFE Test Case (LIX 2016-02-23) in the 
Available Cases tab.  Then right-click and select Simulation. 
 

3.  Set the Start date for the Simulation Data Time Range to 2016-02-23 18:45 
 
4. Click the Simulate Button. 

 
 WES-2 Bridge will attempt to activate GFE and then start CAVE once GFE is activated. 

 
Note:  The Simulation Controls may appear prior to CAVE being ready to start.  Do not press Play until 
after CAVE launches. 
 

5. After CAVE launches, press the Play button in the Simulation Controls Window.  The clock at the 
bottom of the CAVE window should turn red with yellow text.   

 
6.  In CAVE, launch the GFE perspective, either from the CAVE Menu (Perspective ►GFE) or by using 

the Open Perspective Button and choosing GFE. 



 

 
 
 

7.  In the GFE Startup dialog, choose LIX_gfeConfig and press the OK button. 
 

8.  To populate the Fcst Database, we will copy some grids in from some models.  This is just for 
illustrative purposes only.  We will not be doing any particular grid editing, nor a full set of grids. 
 
In the Grid Manager, select the time period for Today, Tonight and Tomorrow, and Tomorrow Night. 
 

 
 
 
Under the Populate menu, choose the Copy All Grids From… option and then choose GFS 2312 
(LIX).  If GFS 2312 is not available, use the model of your choice.  
 
Under the Grids menu, choose Interpolate.  In the resulting dialog, ensure the Gaps option is selected 
and press the OK button. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.  Save the Forecast by using the Save Forecast button (the Diskette icon) or choosing Edit ► Save 
Forecast.  In the resulting dialog, press the Save Forecast button.   
 
Note:  WES-2 Bridge does not have ISC (Intersite Coordination) functionality.  Therefore, when you try 
to save a forecast database, GFE tries to send the grids to a server it can’t connect to.  Later, this can 
cause delays in trying to shut down the EDEX server.  To help avoid this problem, click the Consistency 



menu and then click the ISC Send Enable check box to turn it off.  This obviously is something only for 
WES-2 Bridge and would never be appropriate for real-time operations. 
 

10.  To edit the Hazard grid, go to the Hazards menu and choose MakeHazard.  Select some parishes 
(counties) choose a start time and end time, and a hazard.  
 
In this example, use a Flash Flood watch with these parameters: 
 
  
  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
After making the first hazard, press the Run button.   

 
Choose a different hazard category and create another hazard for some different parishes (counties).  In 
this example, we’ll do a Lake Wind Advisory. 
 
 
Hazard Type Non-Precipitation 
Hazard Lake Wind Advisory 
Begin Date/Time 12Z Wednesday 24 Feb 2016 
End Date/Time 23Z Wednesday 24 Feb 2016 
 
   
 

Hazard Type Hydrology 
Hazard Flash Flood Watch 
Begin Date/Time 22Z Tuesday 23 Feb 2016 
End Date/Time 10Z Wednesday 24 Feb 2016 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After making these selections, press the Run/Dismiss button. 
 
 
After creating the hazards, click Hazards followed by MergeHazards.  Then save the forecast.   
 
 

 



 
11.  This step is about saving the forecast to the Official database.  This is an optional step because the GFE 

software packaged with the WES has not always been reliable about saving the Official files.  
 
Save the forecast as Official.   Use the Products ►Publish To Official option. 
 
Note: Sometimes Publish To Official seems to work without giving errors but does not actually save the 
Official database HDF files.   Because of this, we will run the formatters against the Fcst database in the 
following steps. 

 
12.  To create the text products, under the Products menu, choose Formatter Launcher.  This step will 

create two hazard products (one each for the Flash Flood Watch and the Lake Wind Advisory) and two 
text forecasts (Zone Forecast Product and Area Fire Weather Matrices). 
 
Under DataSource choose Fcst. 

 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Under Products, choose Hazard ►Hazard_FFA (Flood Watch).  Click the Gear button to run the 
formatter. You will get a warning message about using the Fcst database rather than the Official 
database; you can acknowledge this warning. 
 
For Flood Reason, choose Excessive Rainfall and edit the text as desired. 
 
Under Products, choose Hazard ► Hazard_NPW (Non Precipitation).  Click the Gear button to run 
the formatter and edit the text as desired.  Again, acknowledge the warning about using the Fcst 
database. 

 
Under Products, choose ZFP and choose Rest of Today. 
 
Under Products, choose AFM (Area Fire Weather Matrix) and choose Afternoon. 

 
For all of these, edit the products as desired and click the red Transmit button.   
 
Successively hit the Transmit button for all four of these products (the FFA, NPW, ZFP, and AFM).  
Each of these will have several Transmit dialogs and accompanying Transmit buttons to make sure you 
really want to transmit the product. 



 
To see the Flash Flood Watch in the GHG monitor, choose CAVE ►New ► GHG Monitor. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

13. Stop the simulation.  Close GHG.  Close out of the GFE Perspective and exit CAVE. 
 
 
14. WES-2 Bridge will copy the Fcst Database, and the text and warning products into the 

/data1/wesSimData output directory for later viewing.  It is possible to choose a different 
output directory when the simulation is first launched..   
 
To see the products issued, open a terminal window and type cd /data1/wesSimData.  Then go 
into the directory for the particular simulation.  In this example, the simulation directory is 
WES_2_Bridge_1731_GF_201709271445 
 
Look at the various directories as shown in the figure below. The gfe directory contains the Fcst 
database (and Official if it was saved).  The text directory contains the text products and the 
warnings directory contains warnings (including the polygons for severe convective warnings). 
 

 



 



The following steps describe how to load a Fcst database that resulted from a previous simulation.  There are 
at least two reasons to do this: 
 
• Use the Fcst database as a starting point for a simulation (as in real-life where one forecast shift always 

begins with the forecast produced by the previous shift). 
 

• Review the work produced during a previous simulation for evaluation. 
 

In this example, the results of the previous simulation are stored in a directory packaged with the GFE case.  
By default, output directories from previous simulations are stored in /data1/wesSimData, but they can be 
specified to be anywhere on the system, on a simulation by simulation basis. 

 
15.   Start the  GFE case simulation by selecting WES-2 Bridge 17.3.1 GFE Test Case (LIX 2016-02-23) 

in the Available Cases tab.  Then right-click and select Simulation. 
 

16.   Set the Start Date for the Simulation Data Time Range to 2016-02-23 18:15. 
 

17.   Near the bottom of the Simulation settings window, set the Input Data Directory to  
/data1/wes_cases/W2B_17_3_1_GFECase/wesSimData. 

 

 
 

After verifying the settings are correct, click the Simulate button. 
 
The simulation will start up in a manner similar to that above as represented by steps 4 through 7. 



 
18.   When CAVE launches, start the GFE perspective. You should see the Fcst database pre-populated with 

some grids, including the Hazards grid which contains a Blowing Dust Advisory and a High Wind 
Watch. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
19.   The simulation that created the data stored in wesSimData just simply populated grids from the 

HIRESWarw model database, created the hazard grid, and then stopped.  Thus, the grids would be 
ready for potential further editing plus text product creation using the formatters,  if so desired. 



 
20.  Stop the simulation.  Close GHG.  Close out of the GFE Perspective. 
 
21.  Start a third simulation to demonstrate using the HazSimp winter storm watch formatter.  This 

simulation starts with a pre-created Fcst database (although this particular database is not necessarily a 
realistic weather scenario).  The Fcst database contains a Wx grid along with IceAccum and SnowAmt 
grids so that the template has information to populate the watch text. 
 
Start the GFE case simulation by selecting WES-2 Bridge 17.3.1 GFE Test Case (LIX 2016-02-23) 
in the Available Cases tab.  Then right-click and select Simulation. 

 
22. Set the Start Date for the Simulation Data Time Range to 2016-02-23 18:00. 
 
23.   Near the bottom of the Simulation settings window, set the Input Data Directory to 

/data1/wes_cases/W2B_17_3_1_GFECase/HazSimpSimData. 
 

  
  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After verifying the 
settings are 

correct, click the Simulate button. 



 
 
24.  When CAVE launches, press the PLAY button and then start the GFE perspective. You should see the 

Fcst database pre-populated with a Wx grid, and Snow and Ice Accumulation grids. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
We are going to issue a winter storm watch with “blizzard conditions possible” for a set of counties 
and use the default settings of the formatter for another set of counties, based on Wx type set in the 
grid. 

 
 
 
25. Choose Hazards  > Make Hazard.  Use these parameters to generate the hazard: 

 
 
Hazard Type Winter Weather 
Hazard WS.A – Winter Storm Watch 
Begin Date/Time 20Z Tuesday 23 Feb 2016 
End Date/Time 18Z Wednesday 24 Feb 2016 

 
Note:  This is for demonstration purposes.  The correct policy for this situation/forecast period would 
be a warning rather than a watch. 

 



Based on the guidance below (courtesy of a HazSimp briefing via Andy Just), different ETN/Segment 
numbers trigger different language to appear in the text. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
For the snow area, we’ll use a segment number of 101 and for the ice area we’ll use a segment number 
of 1.  Click the counties indicated and then the Run button.    
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
Deselect the previously selected counties and choose a new set of counties as indicated for segment 
number 1.  Then click the Run/Dismiss button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

  
  
 

 
26. Click Hazards ► Merge Hazards, and then save the grids by clicking the Diskette icon.  In the Grid 

Manager select the Hazard grid to verify the counties that were previously selected. 

 
 
 
 
 



27.   To create and edit the watch text products, under the Products menu, choose Formatter Launcher.   
Under DataSource choose Fcst. 
 

28.  In the Formatter Launcher, Under Products, choose Hazards ► Hazard_WSW (HazSimp).  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
 
 
Click the Gear button to run the formatter. You will get a warning message about using the Fcst 
database rather than the Official database; you can acknowledge this warning. 
 
 

 
29. Check the text to verify one segment is for heavy mixed precipitation and the other segment is for 

possible blizzard conditions.  Edit the text to your satisfaction and then transmit the product. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
  
 

 
 

30. Stop the simulation.  Close out of the GFE Perspective and exit CAVE. 



Task 4: Build a short WESSL Script and Play it in a Simulation 
 
Introduction.  A case can contain more than one WESSL-2 script.  We will add a new script to the WES-2 
Bridge 17.3.1 Test Case (LIX 2016-02-23) case.  This script will contain some of the same content as the 
previous script plus some additional media to demonstrate how to use the Script Builder to add various 
commands. 
 
Concepts: 

• Create a new script 
• Add a pre-brief web page (SPC Day 1 Convective Outlook) and image (tornado watch county graphic) 
• Give students a period to do environmental assessment by pausing the simulation 
• Add text to instruct the students to skip forward in the simulation 
• Add a few reports using the Script Builder Local Storm Report Importer. WESSL-2 has the ability to 

import .CSV files containing SPC storm reports to save you from having to enter reports one-by-one.  At 
a WFO, because WES-2 Bridge machines do not have Internet access, you will have to obtain the .CSV 
files on a PC that does have Internet access, then subsequently scp the files to the wes2 workstation (e.g., 
scp file.csv user@wes2:) 

• Add a video 
• Add a recap animated gif using a Linux command to display in a Firefox window.  

  (WESSL-2 does not natively display animated gif files) 
• Stop the simulation 
 

Step-by-Step Instructions: 
 

1. Check to see if EDEX_00 is Active under the “EDEX Instances” tab. If it is listed as Not Active, 
right-click and select Start EDEX.  EDEX_00 MUST be active for Script Builder to run. 

 

 
 
2. In the Case Manager, Right-click on WES-2 Bridge 17.3.1 Test Case (LIX 2016-02-23) and select 

Launch Script Builder. 
 
3. Click on the folder icon, click the New button, and enter a name for your script. 

 



 
 

4. Right-click on the empty Date and Time cell and select “Beginning of Simulation”. 
 

5. Right-click on the empty Command cell and select Text.  In the Text Event box, type “The 
simulation is about to begin.”  Click OK.   
 

 
 
 

6. Click the right arrow in the tool bar to preview the command. 
 
 
 
 
 
 
 
 
 
 
  

  



7. Click the green + sign in the tool bar to create a new row for a new event. 
 

8. Double click on the Date and Time empty cell where you will enter  2016 02 23  17 09 and click 
OK.   
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Right-click in the Command box, and select Presentation. 
 

• Browse through the filesystem to find this HTML page (for the SPC Day 1 Convective 
Outlook):  
 
/data1/wes_cases/W2B_17_3_1_TestCase/wessl2/Resources/ 
Storm Prediction Center Feb 23, 2016 1630 UTC Day 1 Convective Outlook.html 
 
After Opening the file, Click OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

• Click on the Play button to preview the convective outlook web page in the Firefox browser. 
 

Note:  It is a best practice to collect external media (web pages, audio/video/image files) in a 
common directory inside the wessl2 directory.  Here we created a Resources folder inside the wessl2 
directory to contain this content.  This makes the wessl2 script much easier to share with others.   



 
Note:  The 16.2.2 version of WESSL-2 was the first to handle relative pathnames (i.e., using media 
files that are located in the wessl2/Resources folder that is relative to the case directory, rather than 
absolute paths like /data1/wes_cases….).  This change was made to make sharing scripts among 
machines much easier.  Consequently, incompatibilities likely exist with scripts created with the 
earlier versions of WESSL-2 that utilized absolute paths and the referenced media files could be 
located at any location on the machine.  The media files (audio, video, images, notification sounds, 
and presentations/web pages) must be in the Resources folder, and the path names in older scripts 
may need to be adjusted in Script Builder. 

 
Note:  “Presentations” in WESSL-2 normally consist of some type of web-based content, like a web 
page or more interactive content, like Articulate or Camtasia presentations.  All of these require 
multiple (supporting) files in addition to the main .html file that launches the presentation.    
WESSL-2 now automatically copies the main .html file into the Resources folder but doesn’t 
support automatically grabbing the supporting content.  Therefore, when using a Presentation, the 
Script Builder displays a reminder message: 
  
  
 
 
 
 
 
 
 
For the purposes of this job sheet, we have already packaged the supporting content in the Resources 
folder for you, so you can ignore this message.  But this is an issue for when you make your own 
scripts using your own content. 
 

9. Open the drop-down Commands menu at the top of the script builder window and click Storm 
Reports. This will pull up the Local Storm Report Selector window, where storm reports can be 
imported from .CSV files containing SPC storm reports to save you from having to enter reports one-by-
one.   

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
        

Note: At a WFO, because WES-2 Bridge machines do not have Internet access, you will have to      
       obtain the .CSV files on a PC that does have Internet access, then subsequently scp the files to the  
       wes2 workstation (e.g., scp file.csv user@wes2:). For ease we have included the reports   
       file with this case. 
 

mailto:user@wes2


 
• When no reports have previously been imported a pop-up message appears asking if you would like 

to get some. You can also import reports by clicking the “Get New Reports” button (green plus 
sign) at the top of the window. Click “Yes” on the pop-up that appears. 

 
 
 
 
 
 
 
 
 
 

 
 

• The Import Storm Reports window will appear. Click “Add File” and navigate to .CSV file at: 
/data1/wes_cases/W2B_17_3_1_TestCase/wessl2/Resources/160223_rpts.csv 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• After selecting the 160223_rpts.csv file, it should appear in the list. To only import the reports for 
the LIX CWA, select the “WFO Filter” radio button, then scroll through the list and select LIX. 
Reports can also be filtered by Lat/Lon by selecting the “Lat/Lon Filter” radio button and entering 
coordinates for two corners of a filtering bounding-box.  

 
 
 
 
 
 
 
 
 
 
 
 



 
• Click “OK” to import the storm reports. It may take a few moments but once complete the reports 

will appear in the LSR Selector window. You can then close the Import Storm Reports window. 
 

• Select a couple of the hail, wind, and tornado reports. To add them as events in your script, click the 
“Transfer to Script” button (blue arrow) at the top of the window. A summary will pop-up of the 
reports to transfer. Click “OK”. The reports will now appear in your Script Builder window. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
• To reset the window for future users, click “Select” in the top-left corner of the table, then “Select 

All” to select all the reports. Then click the “Delete Reports” button (red minus sign) at the top of 
the window. Repeat this step for all reports tabs (Hail, Wind, Tornado) to fully clear the database of 
reports.  

 
 
 
 
 
 
 
 
 
 
 
 
 
10. Use this table to fill out the remaining events in this script.  You have already entered then the first event  

(at 02/23/2016  17:09:00).  To generate each new event, click the green + sign in the toolbar. 
 

       Note: The media files in this exercise are for instructional purposes. Some of the files do not   
       correspond to the weather event featured in this specific case.  

 
 

Time Command Details 
02/23/2016 
17:09:00 

Presentation Add a web page for the SPC Day 1 Convective outlook.  Browse in the filesystem to  
/data1/wes_cases/W2B_17_3_1_TestCase/wessl2/Resources/ 
Storm Prediction Center Feb 23, 2016 1630 UTC Day 1 Convective 
Outlook.html 
 

02/23/2016 
17:10:00 

Image Add an image of the counties included in Tornado Watch #0019.   Browse to 
/data1/wes_cases/W2B_17_3_1_TestCase/wessl2/Resources/ 
ww0019_counties.gif 
 
For the optional text caption, enter this text:   
Tornado Watch #0019 Issued at 1110 AM CST 



 
02/23/2016 
17:10:15 

Text Enter this text: 
The simulation will pause in 15 seconds to allow you to analyze the 
environment.  When you are finished, use the simulation controls to 
SKIP forward to 02/23/2016 19:14:00. 
 

02/23/2016 
17:10:30 

Text Enter this text:  
The simulation is paused.  
 
To enter a Pause in the script, right click on the green 
checkmark in the first column of the row, and select 
Pause.  
 

02/23/2016 
19:14:00 

Observation Type:  Tornado 
Latitude: 30.68 
Longitude: -90.60 
Text:  Reports of moderate  
damage to a trailer, 3 miles 
east of Montpelier 
 
Note: This is how reports can be added to a script 
manually, without using the Storm Report Importer 
used previously. 
 
 
 
 

02/23/2016 
19:14:15 

Video Browse in the filesystem to: 
/data1/wes_cases/W2B_17_3_1_TestCase/wessl2/Resources/ 
GarlandNTTA.mp4 
 
For the optional text caption, enter this text:   
Video from North Texas Tollway Authority traffic cameras. 
 

02/23/2016 
19:15:00 

Linux  
Command 

Enter this text in the box  (this command text is all one line): 
firefox –new-tab 
file:///data1/wes_cases/W2B_17_3_1_TestCase/wessl2/Resources/ 
myanimation.gif 
 
 
Note: The WESSL-2 Event Browser cannot natively display animated GIFs, but a 
web browser can, so that’s why this Linux command starts Firefox.  Linux 
commands can also run shell scripts to do most any other task. 
 

  
 
 
 

11. After completing steps 3–10, your Script Builder window should be populated with events similar to 
this: 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
12. In practice, here you would close the WES II Script Builder and Event Previewer windows and click 

Yes.   
 

13. In the WES-2 Bridge Case Manager, select WES-2 Bridge 17.3.1 Test Case (LIX 2016-02-23) in the 
Case Name tab, right click, and select Simulation since the case would already be loaded through 
completing Task 2. 

 
14. In the Simulation tab Simulation Data Time Range enter 2016-02-23 17:09 for the Start Date and 

2016-02-23 19:30 for the End Date.   
 

15. Under the WESSL Script, select the script name you created in Step 3.  Click the Simulate button. 
 

16. If it appears, click OK on the available memory popup window, and note when the WESSL2 window 
and Simulation Controls window pops up. 

 
17. Click the PLAY button on the Simulation Controls window. 

 
18. WESSL-2 will display your events as you created them. 

 
 



Task 5:  Examine a Hydro Case and Run a Basic Simulation with Hydro Apps Capabilities: WES-2 
Bridge 17.3.1 Hydro Test Case (LIX 2016-02-23)  
 
Introduction.  Since Build 14.3.1, WES-2 Bridge has had the capability of running simulations using some of 
the basic Hydro Apps (in the Hydro and MPE perspective).  These simulations display hydro data at the proper 
times; RiverPro does not yet work, so product issuance is not yet possible. Running these simulations is not 
difficult, but constructing hydro cases can be challenging.  This task illustrates the structure of a WES-2 Bridge 
case with hydro capabilities and how to access these data.   
 
Note:  Case Review does not work with hydro simulations and attempts to use Case Review with hydro-enabled 
simulations can generate errors.  This will be addressed in future WES-2 Bridge versions.    
 
You will also use one of the two parts of WESSL-2, the WESSL-2 Event Browser, to view ancillary information 
included with the simulation.  
 
Concepts: 

• Examine the structure of a hydro case:   
o caseMetaData.xml 
o hydro database 
o coord_host.dat 
o XMRG files used in Hydro Perspective (gridded FFG and Best Estimate QPE) 
o XMRG files used in MPE Perspective 

• Load a hydro simulation 
• Start a Hydro Simulation. 
• Access various hydro data 
• Use the Skip function to move ahead in the simulation 
• Stop the simulation 
 

 
Step-by-Step Instructions: 
 
1. In a terminal window, issue the following commands to list out the contents of the WES-2 Bridge 17.3.1 

Hydro Test Case: 
 

• cd /data1/wes_cases/W2B_17_3_1_HydroCase 
 

• more caseMetaData.xml 
 
Note:  notice there is a Hydro data type.  This must be manually added to the 
caseMetaData.xml file for a case that has hydro capabilities. 
 

• ls hydro 
 

• ls hydro/* 
 

There are five folders here.  This entire structure has to be manually created because the AWIPS-2 
archiver cannot archive hydro data, partly because the hydro data has different purging mechanisms 
than the rest of the AWIPS-2 datasets. 
 
The following discussion describes the contents of these folders and where the data may be obtained.  
Currently these datasets must be obtained manually and some of the datasets are purged very 
aggressively so there is limited time to grab these perishable files.    



 
 

 
Directory Description How To Obtain 
database copy of hydro database 

for a given case 
(e.g., hd_ob92lix) 

The hydro database is backed up daily in 
/data/fxa/DAILY_BACKUP/postgres/{day of 
week}/hd_ob92xxx. These files require root access. 
 
The database can also be retrieved manually by using a 
pg_dump command on dx1: 
 
pg_dump –Fc –U awips –f /data/local/hd_ob92xxx 
hd_ob92xxx 
 
(xxx is your WFO ID) 
 
Your hydro database contains both static and dynamic 
information.  Among other things, static information includes 
data about rating curves, flood stage impacts, and stream 
gage locations, ownership, contact information and so on.  
Dynamic information is time-dependent, and the database has 
its own purging mechanism. This data comes mostly, but not 
exclusively, from SHEF format data files.  If you manually 
dump your database, you should probably do it the day after 
your event.   It is also possible to reprocess much of the 
SHEF data if the hydro database needs to be reconstructed 
for an event.  
 

geo_data Boundary coordinates 
of the HRAP 
(Hydrological Rainfall 
Analysis Project) grid 
for a WFO.   

This file is different for each WFO.  The gridded data files in 
the remaining directories are in XMRG format (a binary grid) 
using a subset of a national HRAP grid.  Your WFO’s file is 
located at this location on dx3 or dx4: 
 
/awips2/edex/data/share/hydroapps/geo_data/host/ascii/ 
coord_host.dat 
 
This file is necessary to display the griddedffg, best estimate 
qpe and mpe files. It is also necessary if you wanted to 
reprocess XMRG-format HPE files for FFMP. 



 
griddedffg/misc XMRG format 

version of FFG for 
your WFO.  This 
grid is displayable 
in the Hydro 
Perspective 

These files contain gridded FFG for 1-, 3- and 6-hour periods.  
These files normally remain on your system for 2 days.   
 
The files are located in this directory on dx3 or dx4:  
 
/awips2/edex/data/share/hydroapps/whfs/local/data/grid/misc/ 
 
Here are some example filenames for the LIX case: 
 
LIX201602220001.ffg 
LIX201602220003.ffg 
LIX201602220006.ffg 
 
The format is XXXYYYYMMDDHHFF.ffg, where XXX is the 
WFO ID, FF is the forecast period (01, 03, and 06).  Thus, these 
particular files are for February 22, 2016 at 00 UTC. 
 

hpe These are XMRG 
format files for the 
High Resolution 
Precipitation 
Estimates 
produced at your 
own WFO.   

The hydro simulation currently does not utilize these files, but they 
may be useful for reprocessing HPE for FFMP. These are the “raw” 
format files for HPE, Bias HPE, and HPN (HPN files are in a 
“nowcast” directory.).    
 
These files are found at the following directory on dx3 or dx4: 
 
/awips2/edex/data/share/hydroapps/precip_proc/local/data/hpe/ 
 
The previous day’s files up to 09Z are purged each day at 1200 
UTC, so there is a three-hour daily window between 9Z and 12Z 
where files can be obtained for the previous day. 

mpe/qpe These are XMRG 
format files for the 
Best Estimate 
QPE produced at 
your own WFO.  
This gridded data 
is viewed in the 
Hydro 
Perspective.   

These files normally remain on your system for 2 days.   
 
The files are located in this directory on dx3 or dx4:  
 
/awips2/edex/data/share/hydroapps/precip_proc/local/data/mpe/ 
 
Here is an example file from the LIX case:  xmrg0224201607z, 
which is for February 24, 2016 at 07 UTC. 
 
By default, the MMOSAIC (multi-sensor mosaic from MPE) is 
used for the Best Estimate QPE. 

mpe These are XMRG 
format files for 
various 
precipitation 
estimate mosaics 
produced by the 
MPE (Multi-
sensor 
Precipitation 
Estimate) system 
on a local AWIPS 
system. 
 
These are 
viewable by the 
MPE perspective. 

These files normally remain on your system for 2 days, but some 
files have a longer purge time. 
 
The files are located in this directory on dx3 or dx4:  
 
/awips2/edex/data/share/hydroapps/precip_proc/local/data/mpe. 
 
The filename is usually {PRODUCT}YYYYMMDDHHz, where 
PRODUCT is the name of the particular MPE mosaic (e.g. 
MMOSAIC, RMOSAIC, GAGEONLY, etc.) 
 
Here are a few sample filenames: 
 
gageonly/GAGEONLY2016022123z 
mmosaic/MMOSAIC2016022123z 
rmosaic/RMOSAIC2016022123z 
 



 
2. In the WES-2 Bridge case manager, right-click on the “WES-2 Bridge 17.3.1 Hydro Test Case (LIX 

2016-02-23)” and select Load Case. 
 
Note:  Loading and running a simulation for a hydro case is the same as for any other case. 
 

3. Start the simulation by selecting WES-2 Bridge 17.3.1 Hydro Test Case (LIX 2016-02-23) in the 
Available Cases tab.  Then right-click and select Simulation. 
 

4. Set the Start Date for the Simulation Data Time Range to  2016-02-23 16:00  
 

5. Click the Simulate button.   
 
Note:  It may take several minutes for the simulation to initialize.  When the simulation is ready to run, a 
CAVE window should launch and the simulation controls window should appear.   
 

6. Press the Play button in the Simulation Controls. 
 

7. Use the Open Perspective button to change to the Hydro Perspective or use the CAVE menu and choose 
Perspective then Hydro. 
 

8. Find the Bogalusa stream gauge station, in the northeast portion of the CWA (highlighted with a red circle in 
the figure below).  Double-click the station to select it (it becomes highlighted in a red box). Right-click on 
the station, and click Timeseries. 
 

 
 
 
 



 
  

9. In the Time Series Control dialog, highlight the HG RG and HG FF lines in the lower list box and then click 
the Graph button.  You should see a hydrograph similar to the one below. 

 
 
 

10. In the CAVE 
window, click 
Map Data then 
Best Estimate 
QPE.  In the 
resulting Dialog 
Box, ensure the 
Date/time is 2016-
02-23 16 and then 
click the Show 
Data button.   The 
Hydro perspective 
window should 
look similar to the 
image at the right. 
 
 
 



 
11. Find the Simulation Controls window and click the Skip button.  Skip to 2016-02-23 2300 UTC. 

 
Note:  The Hydro Apps displays do not typically auto-update like their D2D counterparts. 
 
 

12. Force the main Hydro Perspective Window to update by finding the Best Estimate QPE dialog, ensuring 
the date is now 2016-02-23 23 and clicking the Show Data button.  Also find the Point Data Control dialog 
(you can choose the MapData menu and Point Data Control option).  Click its Map button to force a 
screen refresh. This display should update and look similar to the image on the next page. 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
13. Find the Time Series 

Control dialog and click 
the Graph button, and the 
hydrograph plot should 
update.  Notice how the 
most recent precipitation 
has caused the stream 
stage to deviate from the 
forecasted values. 
 

14. Use the Simulation 
Controls to STOP the 
simulation.  Finally, 
unload the case. 
 
 
   


